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GENERAL INSTRUCTIONS:  

 

i). This question paper consists of 23 questions in two sections: Section A and B 

ii). Section A has objective type questions, whereas Section B contains Subjective type questions. 

iii). All questions of a particular section must be attempted in the correct order.  

 

 

SECTION – A  

 

1. Answer any 4 out of the 6 questions. 

  i. In a group discussion, Riya maintains eye contact, listens actively, and puts forward her points 

clearly without interrupting others. Which communication style is she using? 

(a) Passive  

(b) Aggressive 

(c) Assertive  

(d) Submissive 

 

(1) 

  ii. You are trying to get in shape in order to impress your friends. Is this an external motivation or 

Internal motivation? 

EXTERNAL MOTIVATION 

(1) 

 iii. What is the shortcut key to print a document?   CTRL+P 

         

(1) 

 iv. Priya is writing a newsletter in MS Word. She needs to display page numbers at the bottom of 

each page. Which option will help her? 

 

(a) Insert → Table  

(b) Insert → Page Number 

(c) Layout → Margins  

(d) Format → Bullets 

(1) 
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 v. An entrepreneur uses imagination and intuition to plan business strategies. Which attitude is 

this an example of? 

 

(a) Risk-averse  

(b) Avoiding responsibility 

(c) Passive approach  

(d) Analytical and innovative thinking 

 

(1) 

 vi. Which of the following action will promote green economy? 

 

(a) Use of non-renewable resources 

(b) Sustainable development  

(c) Social protection  

(d) Creating jobs 

 

(1) 

2. Answer any 5 out of the 7 questions. 

 

   i. Vimal and his sister are watching movies online at the same time on different devices. 

Suddenly, the internet becomes very slow. What is the most likely reason? 

 

(a) Limited Bandwidth being shared  

(b) Incorrect IP Address 

(c) Virus in the router  

(d) Wrong Communication Channel 

 

(1) 

  ii. Which attack involves faking a website or email to trick users into revealing sensitive data? 

 

(a) Denial of Service  

(b) Malware injection 

(c) Phishing  

(d) Spam 

 

(1) 

  iii. LAN or Local  Area Network is about   

 

(a) 10m radius       

(b) 10 km radius      

(c) 50 km radius   

(d)No distance limitation 

 

(1) 

  iv. A number of devices connected with each other through some transmission medium is:  

 

(a) Group          

(1) 
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(b) Network      

(c) Nodes           

(d) System 

 

  v. Which of the following best describes the word “Spam”? 

 

(a) Sending unwanted bulk messages for advertising 

(b) Flooding a server with fake requests 

(c) Encrypting user files for ransom 

(d) Monitoring user activity secretly 

 

(1) 

 vi. A set of rules that govern data communications and represent an agreement between the 

communicating devices is called ______________________ PROTOCOL 

 

(1) 

vii The speed of travel of a given amount of data from one place to another is 

called____BANDWIDTH_______ 

 

(1) 

3.  Answer any 6 out of the 7 questions. 

 

 i. Which attribute opens a link in a new tab? 

 

(a) target="_self"  

(b) target="_open" 

(c) target="_new"  

(d) target="_blank" 

 

(1) 

 ii. Which of the following tags is an empty tag? 

 

(a)  <head>  

(b) <body>  

(c)  <p>  

(d) <br> 

 

OR 

iii. What attribute is required in the <img> tag to specify the image source? 

 

(a)  <source> 

(b) <path>  

(c) <file>  

(d) <src> 

 

(1) 

iv. What is the purpose of the <th> tag in an HTML table? 

(a) To define a header cell 

(b) To define a data cell 

(1) 
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(c) To define a table footer 

(d) To define a table row 

 

v. Which HTML tags define unordered lists? 

 

(a)  <ul> and </ul>  

(b) <ol> and </ol>  

(c) <li> and </li>  

(d) <item> and </item> 

 

(1) 

vi. Which HTML tag is used to create a hyperlink? 

  

(a) <url>  

(b) <link>  

(c) <a>  

(d) <href> 

 

(1) 

vii. Which HTML tag is used to define a drop-down list? 

 

(a) <select> 

(b) <input> 

(c) <option> 

(d) <dropdown> 

 

(1) 

4.  Answer any 5 out of the 6 questions. 

i. What does CSS stand for? 

 

(a) Creative Style Sheets  

(b) Computer Style Sheets  

(c) Cascading Style Sheets  

(d) Colorful Style Sheets 

 

(1) 

ii. Which CSS property is used to change the text color of an element?  

 

(a) text-color  

(b) color  

(c) font-color  

(d) text-style 

 

(1) 

iii. Which CSS property is used to control the spacing between lines of text? 

 

(a)  line-height  

(b)  text-spacing  

(1) 
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(c)  line-spacing  

(d)  text-line 

 

iv. What happens when a user submits a form? 

 

(a) The form disappears from the webpage.  

(b) The form data is sent to the program specified in the <action> attribute for processing.  

(c) The browser displays a confirmation message.  

(d) The behaviour depends on the specific form elements used. 

 

(1) 

v. Which tag do you use to include an external CSS file in your HTML document? 

 

(a)  <css> tag  

(b) <style> tag  

(c) <link> tag  

(d) <script> tag 

 

(1) 

vi. Which attribute is used to specify the action (URL) where the form data will be submitted? 

(a) action 

(b) method 

(c) name 

(d) target 

 

(1) 

5. Answer any 5 out of the 6 questions. 

i. What does GIMP stand for? 

(a) Graphic Image Manipulation Program 

(b) General Image Modification Program 

(c) GNU Image Manipulation Program 

(d) Graphics In Motion Program 

 

(1) 

ii. Which tool is used to enlarge or shrink the size of the image?  

 

(a) Zoom           

(b) Flip  

(c) Clone             

(d) Scale 

 

(1) 

iii. _______________ is the correct combination to duplicate a layer.  

 

(a) Shift + D  

(b) Ctrl + D  

(1) 
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(c) Shift + Ctrl +D  

(d)Shift + Alt + D 

 

iv. The __________________ filters can be used to add artistic effects to an image, such as making 

it look like a painting or a sketch. ARTISTIC 

 

(1) 

v. By default, the foreground colour is white and background colour is black in GIMP. Is this 

statement true or false?FALSE 

  

(1) 

vi The ________ tool is used to select the areas of the image based on colour similarity. COLOR 

 

(1) 

6.  Answer any 5 out of the 6 questions. 

i. What is the output of the given code? 

<script> 

var x=40 

var y=20 

var sum=x-y 

document.write(sum) 

</script> 60 

 

(1) 

ii. What is the output of the given code? 

<script> 

var x=1/0 

document.write(x) 

</script>                 INFINITY 

 

(1) 

iii. ________ is used to convert string to integer value. 

 

(a) Integer()  

(b) ParseInt()  

(c) parseInt()  

(d) Stringtoinit()   

 

(1) 

iv. Which of the following keywords is used to initialize variables in JavaScript? 

 

(a) for  

(b) getElement  

(c) var  

(d) Boolean 

 

(1) 

v. An external JavaScript file will have the extension as: 

 

(a) .html  

(1) 
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(b) .JavaScript  

(c) .jc  

(d) .js 

 

vi. Which of the following is not a valid variable name? 

 

(a) grade_pay  

(b) 2gradepay  

(c) gradepay  

(d) GradePay 

 

     (1) 

 

Answer any 3 out of the 5 questions. 

 

7.  Give two advantages of written communication? 

Two key advantages of written communication are creating a permanent, verifiable record for 

future reference or legal proof, and allowing for greater clarity, precision, and careful 

formulation 

(2) 

8. Define Teamwork? 

Teamwork is the collaborative effort of a group to achieve a common goal or to complete a task 

in an effective and efficient way. 

(2) 

9. List the advantages of using word processor to write a letter? 

The advantages of using a word processor to write a letter include the ability to easily edit and 

format text, store and share documents digitally, use templates for standardized layouts, and 

check for spelling and grammar errors 

(2) 

10 Name few characteristics of a successful entrepreneur? 

Confidence  b. Independence  c. Perseverance  d. Open mindedness 

(2) 

11 What is green economy? 

A green economy is a type of economy that reduces environmental risks and ecological 

dangers. Its core principle is that it encourages sustainable development without degrading the 

environment. 

(2) 

Answer any 3 out of the given 5 questions. 

 

12 Differentiate between LAN and WAN? (2) 
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13 How can you create a hyperlink in HTML? Explain the different attributes you can use with 

the <a> tag. 

 

(2) 

14 How can you change the font size and  background color of elements using CSS? 

The most important attribute of the <a> element is the href attribute, which indicates the link's 

destination. By default, links will appear as follows in all browsers: An unvisited link is 

underlined and blue. 

(2) 

15 What are data types in Javascript? 

? In JavaScript, each value has a data type, defining its nature (e.g., Number, String, Boolean) 

and operations. Data types are categorized into Primitive (e.g., String, Number) and Non-

Primitive (e.g., Objects, Arrays). 

(2) 

16 Ravi is designing a poster in GIMP with three layers: background, image, and text. Why are 

layers useful in such editing? Give two points. 

Layers are useful in GIMP because they allow independent editing of the background, image, 

and text without affecting other elements, providing flexibility to move, resize, or style each 

part separately, and enabling non-destructive workflow for easier changes and complex 

compositions. 

(2) 

Answer any 2 out of the 3 given questions. 

 

17 Describe the following network devices briefly. 

a) Switch b) Gateway 

switch is a networking device that connects various computing/network devices on a computer 

network using packet switching to receive and forward data to the destination A gateway is a 

network device that connects dissimilar computer networks following different protocols 

(3) 
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18 What are the three different ways to give colors in CSS? The three primary ways to specify 

colors in CSS are using keywords, hexadecimal codes, and functional notations [1].  

1. Color Keywords 

CSS defines a set of simple, human-readable keywords for common colors. These are the 

easiest to use and read.  

Examples: red, blue, green, white, black, tomato, skyblue. 

 

(3) 

19 Write a program to accept a side from the user and calculate the area of a square 

function areaOfSquare(side) { 

    return side * side; 

} 

 

const sideLength = 5; 

const area = areaOfSquare(sideLength); 

console.log(`The area of the square is: ${area}`); 

(3) 

Answer any 3 out of the given 4 questions 

 

20 Discuss Phishing and different types of Phishing Scams 

Phishing is a cyberattack using deception (emails, texts, calls) to trick victims into revealing 

sensitive info (passwords, bank details) or downloading malware, disguised as legitimate 

sources. Key types include Email Phishing (mass emails), Spear Phishing (targeted 

individuals), Whaling (executives), Smishing (SMS texts), Vishing (voice calls), Pharming 

(DNS redirection), and Clone Phishing (copied legitimate emails) 

(4) 

21 Write the html code for the given table? 

<tr> 

      <th>NAME</th> 

      <th>CLASS</th> 

      <th>STREAM</th> 

    </tr> 

  </thead> 

  <tbody> 

    <tr> 

      <td>XYZ</td> 

      <td>XI</td> 

      <td>HUMANITIES</td> 

    </tr> 

    <tr> 

      <td>ABC</td> 

      <td>XII</td> 

      <td>SCIENCE</td> 

    </tr> 

    <tr> 

      <td>BCD</td> 

(4) 
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      <td>XI</td> 

      <td>COMMERCE</td> 

    </tr> 

  </tbody> 

</table> 

NAME CLASS STREAM 

XYZ XI HUMANITIES 

   

ABC XII SCIENCE 

BCD XI COMMERCE 
 

22  

The following program is given using if...else if. Use the same program to convert using 

switch..case without changing the meaning of the program: 

 

 <script>  

var grade=parseInt(prompt(“Enter grade of employee”)) 

 if (grade==”A”)  

document.write(“You are Vice President”)  

else if(grade==”B”)  

document.write(“You are LEVEL 1 Officer”) 

 else if(grade==”C”) document.write(“You are a Trainee”) 

 else  

document.write(“You are not employed”)  

</script> 

<script>  

var grade=prompt("Enter grade of employee"); 

switch (grade) { 

    case "A": 

        document.write("You are Vice President"); 

        break; 

    case "B": 

        document.write("You are LEVEL 1 Officer"); 

        break; 

    case "C": 

        document.write("You are a Trainee"); 

        break; 

    default: 

        document.write("You are not employed"); 

} 

</script> 

(4) 

23 a)Use the for loop to print odd numbers between 100-200. 

for (let i = 101; i < 200; i += 2) { 

    console.log(i); 

(4) 
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} 

b) write a program to display whether the given number is divisible by 4 or not? function 

checkDivisibilityBy4(numberToCheck) { 

    if (numberToCheck % 4 === 0) { 

        console.log(`${numberToCheck} is divisible by 4.`); 

    } else { 

        console.log(`${numberToCheck} is not divisible by 4.`); 

    } 

} 

 

// Example usage: 

 

// Case 1: Divisible by 4 (e.g., 16) 

const number1 = 16; 

checkDivisibilityBy4(number1); 

 

// Case 2: Not divisible by 4 (e.g., 21) 

const number2 = 21; 

checkDivisibilityBy4(number2); 

 

 

 


